Contents

Introduction ......................................................................................................... 6
Symbols in this user guide ....................................................................................... 6
Notes ....................................................................................................................... 7
Glossary ................................................................................................................... 7
About ECCMS ....................................................................................................... 8
Key ECCMS functions .............................................................................................. 8
Data migration ........................................................................................................ 8
ECCMS requirements ............................................................................................ 9
Operating system and memory ........................................................................... 9
Internet speed ......................................................................................................... 9
Hardware ................................................................................................................. 9
Browser software .................................................................................................. 10
Locating and using Internet Explorer 11 in Windows 10 ...................................... 10
PDF reader ............................................................................................................. 11
AUSkey .................................................................................................................. 11
User access levels .................................................................................................. 11
Managing AUSkey registrations .......................................................................... 12
AUSKey rules .......................................................................................................... 12
Register the first Administrator AUSkey ............................................................... 13
Install the AUSkey software on your computer .................................................. 14
Install the AUSkey software on a USB stick ....................................................... 15
Administrator AUSkey responsibilities ................................................................. 16
Register another AUSkey user ............................................................................. 17
Manage AUSkey ownership ................................................................................... 17
Use AUSkey on additional computers ............................................................... 18
Troubleshoot AUSkey issues ................................................................................ 18
Access to ECCMS error message ......................................................................... 18
My Gov error ......................................................................................................... 19
Credentials required error .................................................................................... 21
AUSkey USB issues ............................................................................................... 21
Password error ....................................................................................................... 21
General compatibility issues ................................................................................. 21
Getting started ..................................................................................................... 22
Log in for the first time ......................................................................................... 22
Log into ECCMS ..................................................................................................... 24
View and manage the Reminder ......................................................................... 25
Exit ECCMS .......................................................................................................... 25
Understand the To-Do List ................................................................................... 26
Navigate menus ...................................................................................................... 27
Navigate lists .......................................................................................................... 28
Filter a list ............................................................................................................. 28
Display more list items ....................................................................................... 28
Browse a list .......................................................................................................... 28
Sort a column ........................................................................................................ 29
View details .......................................................................................................... 30
Update details in screens ................................................................................... 30
Recognise required fields .................................................................................... 31
Performing administrator responsibilities ........................................................... 33
  Complete tasks on time .................................................................................. 33
  Maintain data and contact details .................................................................. 33
  Ensure AUSkey ownership is up to date ......................................................... 33
  Notify DoE about major changes .................................................................... 33

Updating service provider details........................................................................ 34
  Update service provider main details ............................................................. 34
  Add a new contact ......................................................................................... 35
  Edit a contact ................................................................................................. 37
  About making a contact inactive .................................................................... 38
    Make a contact inactive ............................................................................... 38
  Add a new address .......................................................................................... 39
  Edit an address ............................................................................................... 41
  About making an address inactive .................................................................. 43
    Make a Primary address inactive ............................................................... 43
    Make a Postal or Other address inactive ................................................... 43
  Add a new bank account ............................................................................... 44
  Edit a bank account ....................................................................................... 46

Accepting the Terms and Conditions ................................................................. 47
  Variation to Terms and Conditions ............................................................... 47
  Save or print the draft Terms and Conditions ................................................. 48
  Accept the Terms and Conditions ................................................................. 49
  Save or print the accepted Terms and Conditions ......................................... 50

Managing funding specifications .......................................................................... 51
  Add details for a new funding specification .................................................... 51
  Update funding specification details ............................................................... 53
    Locate and view a funding specification ...................................................... 53
    Update a funding specification’s main details .............................................. 54
  Add and select contacts, addresses and bank accounts .................................. 55
  Select a funding specification’s contacts ....................................................... 56
  Remove a funding specification’s alternate contact ....................................... 57
  Select a funding specification’s bank account .............................................. 58
  Select a funding specification’s postal address .......................................... 59
  Remove a funding specification’s postal address ......................................... 60
  Attach a document to a funding specification .............................................. 61
  View an attached document ......................................................................... 63
  Cancel a funding specification ....................................................................... 63
  Viewing approvals .......................................................................................... 64
    View a funding specification’s approval ................................................... 64
    View all service provider approvals ......................................................... 65

Adding a funding specification’s service details ................................................. 66
  Add or update service details ......................................................................... 66

Tracking allocations and payments ..................................................................... 68
  Annual renewal of funding specifications ..................................................... 68
  About indexation, variations and RCTI .......................................................... 69
  View a funding specification’s allocation ...................................................... 70
Introduction

The Department of Education (DoE) regulates the operation of Early Childhood Education (ECE) services for children from birth to school age. Examples of these services include preschool, long day care and vacation care. As well as performing a regulatory function, the department also supplies some funding to service providers of child education services.

The Early Childhood Contract Management System (ECCMS) provides secure access via the web to service providers funded by the department. ECCMS enables registered service provider users to view their funding information, update service details and other data, and accept Terms and Conditions online.

Audience

This document is intended for staff members of service providers who have SP Admin, SP User and FS User accounts in ECCMS. For more information about user roles, see Managing users.

Assumptions

The following assumptions have been made when preparing this guide:

- Service provider staff know how to use a web browser, such as Internet Explorer.
- Service providers are familiar with DoE funding guidelines.

Exclusions

Information on DoE’s grants programs has been excluded from this document. For specific information about each of the individual grants programs, visit the Funding page on the DoE website.

Symbols in this user guide

Because the ECCMS Service Provider Guide is intended for three types of service provider users with different levels of access, a blue shaded line of text (see below) is used at the front of each procedure to indicate which user types are able to perform the procedure.

For: SP Admin, SP User and FS User
Notes

When information is important and should be emphasised in the *ECCMS Service Provider Guide*, it is highlighted as shown below.

This is a note which you should read carefully.

Glossary

Acronyms and terms that are specific to this document are recorded in the following table.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocation</td>
<td>The amount of money that DoE funds to a service provider for services carried out via a funding specification.</td>
</tr>
<tr>
<td>ARIA Classification</td>
<td>The Accessibility/Remoteness Index of Australia which is used to rate funding specifications.</td>
</tr>
<tr>
<td>CCB</td>
<td>Child Care Benefit is a payment from the Australian Government that helps families with the cost of child care.</td>
</tr>
<tr>
<td>Delivery Setting</td>
<td>The type of location from which the service is delivered, e.g. centre-based school, general community setting. This information is relevant to census data.</td>
</tr>
<tr>
<td>Funding specification</td>
<td>A funding specification is the details of contracted services (e.g. activities, client groups and number of children) that are provided in one outlet by a service provider in return for funding.</td>
</tr>
<tr>
<td>Hub</td>
<td>NSW regions in ECCMS have been reorganised into hubs to assist the internal management of funding. To view a map of the hubs, see <a href="#">Appendix A: Early Childhood Education hubs</a>.</td>
</tr>
<tr>
<td>Payment schedule</td>
<td>A list of the payments to be made to a service provider under the terms of a particular agreement.</td>
</tr>
<tr>
<td>Payments</td>
<td>The payments to be paid under a funding agreement for a funding specification for the provision of services.</td>
</tr>
<tr>
<td>RCTI</td>
<td>A Recipient Created Tax Invoice provided by DoE to service providers.</td>
</tr>
<tr>
<td>Service provider</td>
<td>An approved organisation such as a child care centre which is legally contracted to provide agreed services via a funding specification.</td>
</tr>
<tr>
<td>SEIFA Band</td>
<td>A Socio-Economic Index for Areas Band is based on the Australian Bureau of Statistics index which ranks areas according to relative socio-economic advantage and disadvantage.</td>
</tr>
<tr>
<td>Terms and Conditions (T&amp;C)</td>
<td>An agreement that outlines the Terms and Conditions for organisations that provide a service to DoE.</td>
</tr>
</tbody>
</table>
The Early Childhood Contract Management System (ECCMS) provides secure access to all funded service providers via the web. ECCMS supports contract and funding administration, provides visibility of service details, coordinates data maintenance and promotes accountability and monitoring.

Key ECCMS functions

The key functions of ECCMS are:

- **Program Management** – the management of programs as a high level source of funds, including program details such as objectives, target groups and budget allocation. (The Program Management function is only visible to DoE staff.)
- **Service Provider Management** – the management of service provider organisations that run one or more outlets (i.e. funding specifications) to provide early childhood services.
- **Funding Specification Management** – where renewals, allocations, payments, accountability and data management is handled for funding specifications.
- **Payment Management** – the calculation of allocations, scheduling of payments and handling of indexation and variations.
- **Census Data Collection** - where preschool data is collected every August by the Department of Education (DoE).
- **User Management** – the management and creation of users with appropriate levels of access to ECCMS.

Data migration

As a result of the NSW government’s restructure of its departments, the early childhood education function moved from Family & Community Services (FACS) to the Department of Education (DoE).

Historical and master data from the FACS application of Community Online Management System (COMS) has been migrated to ECCMS. However, because COMS did not collect exactly the same data as ECCMS, some historical data is not available.
ECCMS requirements

The minimum requirements for successfully running ECCMS on a computer are listed below. If you are unsure about any of these requirements, check with your organisation’s IT Service Desk or phone DoE on 1300 755 426 or email ecec.funding@det.nsw.edu.au.

Operating system and memory

The following operating systems and memory requirements are supported by ECCMS.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Memory requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista</td>
<td>1 gigabyte (GB) memory (2 GB recommended)</td>
</tr>
<tr>
<td>Windows 7</td>
<td>2 GB memory (4 GB recommended)</td>
</tr>
<tr>
<td>Windows 8</td>
<td>2 GB memory (4 GB recommended)</td>
</tr>
<tr>
<td>Windows 10</td>
<td>2 GB memory (4 GB recommended)</td>
</tr>
<tr>
<td>Mac OS X 10.7 or above (using Firefox)</td>
<td>2 GB memory (4 GB recommended)</td>
</tr>
</tbody>
</table>

Internet speed

To support efficient loading of ECCMS data, an internet speed of 1.5 Mbps downstream and 256 Kbps upstream is necessary. ADSL1, ADSL2 or ADSL2+ and cable should meet these requirements.

Internet speed may be an issue if you use a dial-up connection.

Hardware

Any personal computer (PC) bought from 2009 should be able to meet ECCMS’s hardware requirements.

In addition, users should have a monitor that is at least 17” wide and set to 1280 x 1024 resolution. While it is possible to use ECCMS on a monitor with a lower resolution of 1024 x 768, some items on the screen may wrap across two lines.
Browser software

Because ECCMS is a web-based application, each user must have one of the following web browsers installed on their computer:

- Internet Explorer (IE) 11 (Windows). We recommend that you avoid using IE 8, 9 and 10.
- Mozilla Firefox 43.0 or above (Windows and Mac OS X).

For a full and up-to-date list of compatible browsers and operating systems, including Safari and Mac OS, visit the AUSkey compatibility web page at https://abr.gov.au/AUSkey/Help-and-support/Setting-up-AUSkey-troubleshooting/AUSkey-compatibility/

Browsers should **not** be run in compatibility or metro modes. Chrome and Microsoft Edge are not supported.

Locating and using Internet Explorer 11 in Windows 10

In Windows 10, Microsoft has replaced Internet Explorer with the Microsoft Edge web browser, which is currently not compatible with AUSkey. However, you can still locate and pin Internet Explorer 11 to your Windows **Start** Menu or Taskbar for easy access.

1. Click the Windows **Start** button to display the Windows **Start** menu and search box.
2. In the search box, type **Internet Explorer**.
3. In the search results, right-click on **Internet Explorer**, and then on the menu click one or both of these options:
   - **Pin to Start** to pin an Internet Explorer option to your **Start** menu.
   - **Pin to taskbar** to pin an Internet Explorer icon to your taskbar.
4. To open Internet Explorer, click the newly created option or icon.

The Microsoft Edge icon looks similar to the Internet Explorer icon. Ensure you click the Internet Explorer icon.
PDF reader

Each SP Admin and SP User must have Adobe Reader installed on their computer so they can view documents such as the Terms and Conditions document which is created in PDF format. (For more information about user roles, see Types of users.)

PDF is an abbreviation for Portable Document File. PDFs are the best way to ensure information is presented in the intended way, independent of fonts installed on your computer.

It is recommended that at least version XI of Adobe Reader is installed on computers. To install the latest version of Adobe Reader, visit Adobe’s download web page (http://www.adobe.com/au/products/reader.html).

AUSkey

AUSkey is way of authenticating and validating users of Government web applications and services. If a service provider already has an AUSkey (for example, for sending information to the Australian Tax Office), they can use that AUSkey to access ECCMS. The same AUSkey user ID and password allows access to all participating Government applications and web services.

Each ECCMS user must have a working AUSkey which is then linked to their ECCMS account. For more information, see Managing AUSkey registrations.

User access levels

Each ECCMS user is assigned a role which has a set of associated permissions that controls access to functions such as updating banking details and viewing payment history.

If a user does not have the correct permission levels in ECCMS, access to the various functions will not be granted even if they authenticate via AUSkey.

For more information about permission levels, see Types of users.
Managing AUSkey registrations

Each new ECCMS user who does not already have an AUSkey on their computer, must register for an AUSkey and then download free software which installs on their computer.

The new ECCMS user must link their AUSkey login with their ECCMS login so that the correct authorisation is applied. For more information, see Log in for the first time.

AUSkey rules

For AUSkey to work correctly for an ECCMS user, the following rules apply.

- Each service provider’s staff member who needs to log into ECCMS must have their own AUSkey.

  Staff must not share their AUSkey. Each individual ECCMS user must have their own AUSkey.

- A service provider’s AUSkey must have the same ABN and email address as registered in ECCMS. The service provider’s name must also be spelt exactly the same.

- The first AUSkey that a service provider organisation applies for must be an Administrator AUSkey.

- The person who completes the registration for an Administrator AUSkey must be recorded in the Australian Business Register (ABR) in connection with the organisation’s Australian Business Number (ABN) and be one of the following:
  - Trustee
  - Public Officer
  - Director
  - Partner
  - Office Bearer of a club/association.

If the applicant for the Administrator AUSkey is not already one of the above office bearers who are recorded in the ABR, they must complete the Change of registration details form (NAT 2943) from the Australian Taxation Office (ATO). This form can be ordered through the online ATO Publication Ordering Service or by phoning 1300 287 539.

The applicant will need to provide proof of their status within the organisation, for example through the minutes of a Board Meeting.

- An AUSkey must be used at least once every 12 months, otherwise it will expire.
Register the first Administrator AUSkey

The first AUSkey that a service provider organisation applies for must be an Administrator AUSkey.

Before registering for an AUSkey, you should check whether your service provider organisation has previously registered for an Administrator AUSkey. This is important for large organisations where the AUSkey holder may be in another business unit or section of the organisation, for example, a finance unit.

To register online for an Administrator AUSkey, you will need to enter:

- the ABN of your service provider organisation (which must be the same ABN recorded in ECCMS)
- your full legal name
- your date of birth
- an email address that only you have access to (the same one that is recorded against your user ID in ECCMS)
- your personal tax file number (TFN) to speed up the registration. This is not mandatory, but if you don’t provide your TFN you will need to call the ABR and provide extra details.

The AUSkey help desk’s phone number is 1300 287 539.

1. Ensure you have all of the relevant information (see above) close at hand.
2. In your web browser, e.g. Internet Explorer, access the Australian Business Register website: www.auskey.abr.gov.au.
3. On the menu bar, click Registering for AUSkey, and then click Register for an AUSkey.
4. On the Register for an AUSkey page, scroll down to the bottom, and then click the Register for an AUSkey button.

5. On the Register for an AUSkey page, enter your service provider ABN, and then click Next.
6. On the Registration details page, to the Are you an eligible person question, click Yes, and then click Next.

You can only proceed with the registration if you are listed on the ABR as a person who is associated with your service provider.

7. At the bottom of the new page, select I will be the Administrator AUSkey holder, and then click Next.
8. On the Your details page, enter all of your details including the email address that you use for ECCMS.

The email address must be the same as the address that you will use to register for ECCMS.
Managing AUSkey registrations
Register the first Administrator AUSkey

9. Type the Captcha code, and then click Next.

10. On the Confirm details page, check your details and if you are sure they are correct, click Submit.

11. On the Submitted page, take note of the Activation code. Either write down your activation code in a safe place or print the page.

If you lose or forget your activation code, you will not be able to activate AUSkey and you will have to register again to receive a new code.

After the ABR processes your registration, they will send you an email with an installation link. See Install the AUSkey software on your computer.

Install the AUSkey software on your computer

After the ABR processes your AUSkey registration, they will send you an email with an installation link.

1. Open the email and click the AUSkey install link.

   The Install AUSkey - Checking for required software page opens.

   Do not press any keys. Wait until your computer is checked to determine whether it has the latest version of Java software, which is necessary for AUSkey to run.

   If the “There is just one more step before you can install your AUSkey...” message displays, your computer will have to be updated with the latest Java software.

   If your computer has to be updated, you may need to ask for help from an IT specialist. Otherwise, you could click the Updating and installing Java software... link and install the Java software yourself.

   After the Java software is updated, you will need to click the install link in the email from the ABR and try again.

   The installation of the Java software is not covered in this user guide.

2. If your computer has the latest version of the Java software, a Do you want to run this application window displays. To start the AUSkey installation, click Run.

3. On the Install AUSkey page:
   - Type your Activation code (obtained during registration).
   - Confirm your details.
   - Enter a password for your AUSkey.

4. Click Next.

   The AUSkey page opens.

   You are ready to test whether your AUSkey installation is successful.

5. Click Login.

   When the AUSkey Authentication Service starts to open, a “Do you want to trust the website” message may display. Because this is a secure Government website, it is OK to trust it. Click Trust.

   If your computer is able to authenticate successfully, you are ready to start the process of logging into ECCMS. See Log in for the first time.
However, if the Authentication Service fails, you should phone the ABR on 1300 287 539 for assistance.

As soon has you have registered for an AUSkey and you have installed the software on your computer, contact DoE and request an ECCMS login. Make sure that you provide DoE with the **same name, ABN and email address** that you used when registering for the AUSkey.

**Install the AUSkey software on a USB stick**

Installing your AUSkey on a USB stick allows you to use it on multiple computers.

AUSkey on a USB stick will only work with Windows operating systems.

When using AUSkey on a USB stick to access ECCMS, the ability to print documents is limited.

1. Download the AUSkey software for your USB stick from this web page: [https://abr.gov.au/AUSkey/Setting-up-your-AUSkey/Set-up-AUSkey-on-a-USB-stick/](https://abr.gov.au/AUSkey/Setting-up-your-AUSkey/Set-up-AUSkey-on-a-USB-stick/).

   Save the software file (without changing its name) to your computer desktop so it's easy to find later. Don't save the file to your USB stick.

2. Plug the USB stick into your computer.

3. Double-click on the file you have just downloaded to your desktop and follow the prompts to install the software on your USB stick.

4. On your USB stick, double-click on **AUSkey Browser.exe**.

   The AUSkey browser opens.

5. Open your AUSkey registration confirmation email and copy the link under **Install your AUSkey**, and then paste it in the address bar of the AUSkey browser.

   The **Install AUSkey** web page opens.

   Don't copy the address to your normal internet browser as this will install the AUSkey to your computer.

6. Follow the prompts to activate your AUSkey. During the activation you will be asked to:
   - enter the activation code you received at the end of your registration
   - confirm your details
   - enter a password for your AUSkey.
Use AUSkey from your USB stick

Follow these steps to use AUSkey on your USB stick to access ECCMS.

1. Plug your USB stick into the computer.

2. On your USB stick, double-click on **AUSkey Browser.exe**.
   
   The AUSkey browser opens at the ABR website by default.

3. In the address bar, enter or copy and paste the web address of the ECCMS web page:

4. Press ENTER on your keyboard.
   
   You are now ready to start the process of logging into ECCMS. See **Log in for the first time**.

Administrator AUSkey responsibilities

The person who is registered for the **Administrator AUSkey** can:

- register other Administrator AUSkey users
- register Standard AUSkey users
- update or cancel AUSkeys
- obtain additional AUSkeys to use on other computers.

To perform the above tasks, the Administrator AUSKey must log into the **AUSkey Manager** which is accessed via the ABR website at [https://abr.gov.au/](https://abr.gov.au/). On the homepage, in the **Online services** box, click **Login**.
Register another AUSkey user

A person with an Administrator AUSkey can register a new user for a Standard AUSkey or an Administrator AUSkey.

The fastest way to register a new AUSkey user is to log into AUSkey Manager and select the appropriate option under Register New AUSkeys.

To register a new AUSkey user, you will need:

- the full legal name of the new user
- the user’s email address.

When you register a new user for a Standard AUSkey, they will be able to download and test their AUSkey straight away. An email with instructions on how to set up their AUSkey will be sent to them from the ABR.

After AUSkey is working, an account must be set up in ECCMS for the new user. The SP Admin can create an SP User or FS User account. Otherwise, to have DoE set up a new SP Admin user in ECCMS, phone the Early Childhood Education Directorate (ECED) Funding Team on 1300 755 426 or email ecec.funding@det.nsw.edu.au.

Manage AUSkey ownership

A person with an Administrator AUSkey can manage the AUSkeys of staff in their organisation via the AUSkey Manager. For more information, see Administrator AUSkey responsibilities.

Only an SP Admin user in ECCMS can submit the Terms and Conditions, accountability statements and census data. Therefore each service provider must have at all times, one SP Admin user who has a working AUSkey access.

Manage access if an AUSkey user leaves the organisation

Before a staff member who has the Administrator AUSkey leaves an organisation, they should set up another user as the Administrator AUSkey. The person with the new Administrator AUSkey should then cancel the old Administrator AUSkey.

To set up another user as the Administrator AUSkey, certain rules apply. See AUSkey rules.

If the staff member with the Administrator AUSkey leaves an organisation without arranging the cancellation of their AUSkey, you must call the AUSkey help desk on 1300 287 539 as soon as possible and ask them to cancel the AUSkey.

When a staff member with a Standard AUSkey leaves the organisation, the AUSkey Administrator should delete this persons’ AUSkey profile in Access Manager and also make their ECCMS user account inactive. See Make a user inactive.

If the staff member who is leaving the organisation has SP Admin rights to ECCMS, a new SP Admin user must be nominated. This person must be registered for AUSkey and have it installed on their computer, if they do not have it already. Then DoE will need to create a new SP Admin user in ECCMS. To arrange this, phone the Early Childhood Education Directorate (ECED) Funding Team on 1300 755 426 or email ecec.funding@det.nsw.edu.au.
Manage access if AUSkey user is on holidays

If the SP Admin user will be away for the recording or submitting of documents or data, it is important to nominate another staff member who can act in their absence.

The person with the Administrator AUSkey should ensure the temporary SP Admin user is registered for AUSkey and has it working on their computer. (The temporary user could be registered as a Standard AUSkey user.) Then DoE will need to create a new SP Admin user in ECCMS. To arrange this, phone the Early Childhood Education Directorate (ECED) Funding Team on 1300 755 426 or email ecec.funding@det.nsw.edu.au.

Use AUSkey on additional computers

An ECCMS user will need an additional AUSkey if they need to log into ECCMS on another computer. This additional AUSkey must be used by them only.

An additional AUSkey can be installed directly onto a computer or onto a USB stick.

The Administrator AUSkey can obtain an additional AUSkey to use on another computer in AUSkey Manager under Get Additional AUSkey.

When applying for an additional AUSkey for another computer – the same ABN, name and email address (as for the first AUSkey) must be used.

Troubleshoot AUSkey issues

If a user is unable to connect to ECCMS, the SP Admin user can do the following investigations to help resolve the problem.

Access to ECCMS error message

An ECCMS user may receive this error message: “Access to ECCMS is only available for approved, funded Service Providers. To access ECCMS, registration is required”.

This error usually displays because:

- The user has not registered their user account in ECCMS. See Log in for the first time.

OR

- The details the user is using to log into ECCMS with do not match the details they used to register with AUSkey.

To resolve this error:

1. Check whether the person has a user profile in ECCMS. (On the ECCMS menu, point to Administration, and then click User Details.) If they have a profile, take note of the spelling of their name, their ABN and email address.

2. Phone AUSkey support and check that the user's name, ABN and email address are identical to what is in ECCMS.

3. If the details are not identical, update the details in ECCMS so that they are identical.

However, if the details do match and they still cannot log in, contact ECE.
My Gov error

Occasionally an ECCMS user will be redirected to the MyGov website instead of the ECCMS login page. MyGov may also appear in the credential drop-down list.

To resolve this error, the user must delete their browser cookies and then restart their computer.

1. If the user is using the Firefox browser, instruct them to follow steps 2 to 3.
   Otherwise, if the user is using Internet Explorer, instruct them to follow steps 4 to 6.

Remove cookies from Firefox

2. On the menu, click Options. Then click Privacy and under History, click remove individual cookies.

3. In the Cookies window, click Remove All.
Remove cookies from Internet Explorer

4. On the **Tools** menu, click **Internet Options**.

5. On the dialog box that displays, on the **General** tab, click **Delete**.

6. In the **Delete Browsing History** window, ensure the first four check boxes are selected, and then click **Delete**.

Restart computer

7. Restart the computer, and then try to log on again.

If the problem persists, the user should contact AUSkey.
Credentials required error

If a user does not have an AUSkey installed on their computer, the Australian Government Authentication Service – Credential required screen will display.

The user should click Cancel to close the screen. They will need to register for an AUSkey (if they have not done so already) and then ensure AUSkey is installed on their computer.

AUSkey USB issues

If a user is accessing AUSkey via a USB stick, they may experience problems with the version of Firefox (which is embedded in the AUSkey software for USBs) and compatibility.

AUSkey on a USB stick is only supported on Windows and no browser is required as a portable Firefox is embedded.

If a user's AUSkey user ID doesn't appear in the list on the AUSkey Authentication Service screen, the Keystore.xml file may be missing.

Check whether the user has a Keystore.xml file on their USB stick. The file should be located in \AUSkey browser\AUSkey\keystore.xml.

If the Keystore.xml file is missing, contact the person who registered the AUSkeys for your organisation and ask them to copy the Keystore.xml file to the USB.

To resolve a USB issue, the user should contact the AUSkey help desk on 1300 287 539.

Password error

If a user forgets their password and are locked out of AUSkey, they must register for AUSkey again and reinstall the AUSkey software on their computer.

General compatibility issues

A user may encounter other error messages and screens if the software they are using is incompatible. To ensure they are using the correct versions, see ECCMS requirements.
Getting started

This chapter contains information to help you to log in, navigate and understand how to use ECCMS.

Log in for the first time

As a new user of ECCMS, you will receive your Registration Key and login details from DoE via email. The first time that you log in, you will need to link your AUSkey login with your ECCMS login.

Before attempting to log into ECCMS, ensure you have registered with AUSkey and have downloaded the appropriate files to your computer. For more information, see Managing AUSKey registrations.

For: SP Admin, SP User and FS User

1. Access the ECCMS page on the DoE website.

2. Click the ECCMS link.
   
The AUSkey Authentication Service screen displays.
3. Select your user name in the list and then type your **Password**.

4. Click **Continue**.

   The ECCMS Registration screen opens and displays your user name and your organisation's ABN.

   This screen only displays the first time you log into ECCMS.

5. Open the “New ECCMS User Registration Details” email that you received, copy the Registration Key, and then paste it into **Registration Key**.

   Your registration key will look similar to this: 76634ga0-410a-2cd3-e4d6-c121c113c044.

   The registration key must be entered exactly as it appears in the email. This includes all dashes, numbers and letters.

   If you copy and paste the registration key, ensure you do not accidentally add a space to either the beginning or the end of the key.

6. Click **Submit**.

   The ECCMS welcome screen (or To-Do List, if you are an SP Admin) displays.

   If after a few attempts, you cannot log into ECCMS, phone DoE on 1300 755 426 or email ecec.funding@det.nsw.edu.au.
Log into ECCMS

For: SP Admin, SP User and FS User

1. Access the [ECCMS page](#) on the DoE website.

2. Click the ECCMS link.
   The AUSkey Authentication Service screen displays.

3. Select your user name in the list and then type your **Password**.

4. Click **Continue**.
   The ECCMS welcome screen displays.
   
   If you are an SP Admin user, a **Reminder** message may display and then the **To-Do List**. For more information, see [View and manage the Reminder](#) and [Understand the To-Do List](#).
View and manage the Reminder

Only SP Admin users (i.e. Service Provider Administrators) receive a Reminder message when they log in or access the To-Do List. This message lists any outstanding items (such as a Statement of Expenditure) that the service provider must submit.

To clear this message, click OK.

To stop this message from displaying again, select the Do not show this message again check box, and then click OK.

Exit ECCMS

To exit ECCMS, simply close the browser tab or window.
Understand the To-Do List

Only SP Admin users (i.e. Service Provider Administrators) have access to the To-Do List. The To-Do List provides a visual display so that SP Admin users can quickly see what tasks and documents in ECCMS are outstanding.

SP Admin users should check the To-Do List at least once a week to ensure all tasks are complete.

These four areas are represented in the To-Do List by pie charts:

- **Terms and Conditions** – indicates whether the Terms and Conditions have been accepted (see [Accepting the Terms and Conditions](#)).
- **Funding Specification Status** – indicates how many of the service provider’s funding specifications have a status of **Active**, **Hold** or **Cancelled**.
- **Financial Accountability** – indicates whether any Statements of Expenditure need to be submitted (see [Complete the Statement of Expenditure](#)).
- **Performance Accountability** – indicates whether any Performance Accountability Statements need to be submitted (see [Complete a Performance Accountability Statement](#)).

If any of these areas are not applicable, “No records found” may display.

When viewing the charts, the colour orange indicates a task or document is in draft form and must be submitted. The colour green indicates a task or document has been submitted. In the **Funding Specification Status** section, orange indicates that a funding specification is on hold or cancelled – whereas green indicates a funding specification is active.

Click on a hyperlink (e.g. a Funding Specification Name) to access the task or document which must be submitted. Funding specifications are listed by name.
Navigate menus

Objects and functions in ECCMS are grouped into menus and tabs.

To access a menu option, click the appropriate option on the left navigation pane. Then click a horizontal tab to view more details.

The To-Do List, Administration and Applications menu options are not visible to SP Users or FS Users.

The Service Provider menu option is not visible to FS Users.
Navigate lists

Filter a list

Most lists in ECCMS can be filtered by one or more column attributes. For example, the list of funding specifications can be filtered by one or more of these attributes: **Funding Specification Name**, **Hub** and **Status**.

To filter by an attribute, type the first letter or letters of the attribute in the search box. For example, type *w* in the **Hub** search box to list all funding specifications in the Wiradjuri hub.

Display more list items

To display more list items on your screen, select a larger number (e.g. 15 or 20) in the number list.

Browse a list

You can navigate through a list of items, by clicking a navigation button.

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To go to the...</th>
</tr>
</thead>
<tbody>
<tr>
<td>First page</td>
<td>Beginning of the list</td>
</tr>
<tr>
<td>Last page</td>
<td>End of the list</td>
</tr>
<tr>
<td>Next</td>
<td>Next page</td>
</tr>
<tr>
<td>Previous</td>
<td>Previous page</td>
</tr>
</tbody>
</table>
Sort a column

Many lists in ECCMS can be sorted according to the alphabetical or numerical order of a particular column. A column can be sorted if it has UP and DOWN arrows next to the column name, as shown below.

<table>
<thead>
<tr>
<th>Maximum Capacity</th>
<th>Approval Status</th>
<th>Approval Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>Approved</td>
<td>31/08/2013</td>
</tr>
<tr>
<td>11</td>
<td>Under assessment</td>
<td>03/09/2013</td>
</tr>
<tr>
<td>33</td>
<td>Refused</td>
<td>05/09/2013</td>
</tr>
<tr>
<td>33</td>
<td>Cancelled</td>
<td>05/09/2013</td>
</tr>
<tr>
<td>40</td>
<td>Approved</td>
<td>25/01/2012</td>
</tr>
<tr>
<td>30</td>
<td>Approved</td>
<td>25/01/2012</td>
</tr>
<tr>
<td>40</td>
<td>Lapsed</td>
<td>25/01/2012</td>
</tr>
</tbody>
</table>

To sort from ‘A to Z’ or from ‘0 to 9’, click the UP \(\uparrow\) arrow.

To sort from ‘Z to A’ or from ‘9 to 0’, click the DOWN \(\downarrow\) arrow.

When you click an UP or DOWN arrow for the first time, the column name and the other arrow change colour to orange. The clicked arrow disappears. As soon as you click an arrow in another column, the arrows in the previous column resume their original state.
View details

In many lists in ECCMS it is possible to click a row to view more details.

To view or edit the details of an item, click on the item’s row. The selected row is then highlighted in yellow and the item’s details open in the bottom part of the screen.

Update details in screens

Whether you can, or cannot, update details in a screen depends on your user access level in ECCMS and whether a record has been approved or made active.

In ECCMS, fields with black text, and also fields with faded text, are protected and cannot be changed.

Only active fields or fields with blue text can be changed.
Recognise required fields

Required information, that is information which must be entered when creating or editing an item in ECCMS, is marked with an * asterisk.

![Required fields example](image)

Understand success and error messages

When you perform a function such as Save in ECCMS, a gold ‘success’ or ‘error’ message displays briefly at the top right corner of your screen.

It is important to take note of these messages because not only do they confirm your changes are successful, they also (if applicable) advise you why an error has occurred.

![Success message](image)

![Error message](image)

In addition, if you forget to complete a required field or if you enter information in an incorrect format, ECCMS also outlines fields in red and changes field names from black to red.

![Invalid input example](image)

Access online help

On the top-right corner of each screen in ECCMS there is a Help button which opens the online help in a popup window. The online help provides an overview of the current screen and any actions you can perform while on that screen.

![Online help example](image)
Access the interactive eLearning

To learn how to use ECCMS at your own pace, click the Interactive eLearning menu option on the left navigation pane. Depending on your internet browser, the eLearning will open in a new tab or window. You can work your way through all the eLearning modules or just do the modules which will most benefit you.

Add and select contacts, addresses and bank accounts

In ECCMS adding a contact or an address to a funding specification consists of two steps – an add step and a select step.

1. Add the contact or address via the appropriate tab on the Service Provider Main Details screen.

   Only SP Admin, SP User and DoE users can complete this step. FS Users cannot add a contact or an address.

2. Select the contact or postal address via the appropriate tab on the Funding Specification screen.

   SP Admin, SP User, FS User and DoE users can complete this step.

   Only DoE can select a street address.

   The steps for adding a bank account in ECCMS are similar. However, after a bank account is added in ECCMS, an Application for Direct Electronic Funds Transfer form is sent to the service provider for completion. DoE then processes the form and makes the bank account active. See Add a new bank account.

Auditing

All significant additions and changes made by users in ECCMS are recorded for auditing and security purposes. Only DoE has access to this audit information.
Performing administrator responsibilities

SP Admin users have the following responsibilities.

Complete tasks on time

The SP Admin user should check the To-Do List at least once a week to ensure all tasks are complete. The To-Do List provides a visual display so that SP Admin users can quickly see what tasks and documents in ECCMS are outstanding. For more information see Understand the To-Do List.

Maintain data and contact details

ECCMS holds all the details for your service in relation to Department of Education funding, including addresses, contact details and bank details. It is important that these are accurate and up to date, so regularly make time to ensure that details in ECCMS are correct.

Ensure AUSkey ownership is up to date

If staff who are registered for AUSkey and ECCMS are leaving your organisation or are going on holidays, you must carefully manage the AUSkey ownership so that access to ECCMS is maintained. For more information, see Managing AUSkey registrations.

Notify DoE about major changes

If major changes occur to your service provider organisation and/or funding specification(s), you are required to immediately advise DoE of these changes as they may affect your access to ECCMS and/or your payments. You must inform DoE about any changes to:

- operational status, e.g. the closure of a service
- service provider name
- funding specification name
- ABN
- GST requirements
- a funding specification’s street address.
A new service provider can only be added in ECCMS by DoE. However, an SP Admin and an SP User are able to update service provider details.

Update service provider main details

**For:** SP Admin and SP User

1. On the ECCMS menu, click **Service Provider**.

On the Main Details tab, fields with black text such as **Service Provider Name**, **ABN**, **Service Provider Type** and **GST Registered** are protected and cannot be changed. Only active fields and fields with blue text can be changed.

2. Type your service provider organisation's main **Phone Number**. It must have 10 numbers and no spaces, e.g. 0292656808.

3. In **Email**, type the main contact email address for your service provider organisation.


5. Click **Save**.
Add a new contact

It is possible to add an *Alternate* and a *Primary* contact for your service provider organisation and to add FScontact contacts for associated funding specifications. An *FScontact* can be a funding specification’s Primary Contact, RCTI Contact or Alternate Contact.

**For: SP Admin and SP User**

1. On the ECCMS menu, click *Service Provider*.
2. Click the *Contacts* tab.
3. Click *Add New Contact*.
   
   The *Add New Contact* dialog box displays.

4. In the *Title* list, select the appropriate title for the contact.
5. Type the contact’s *First Name* and *Family Name*.
6. In the *Job Title* list, select the appropriate title.
7. In *Email*, type the contact’s email address.
8. Type the contact's **Phone Number**. It must have 10 numbers and no spaces, e.g. 0247832534.

9. Type the contact's **Mobile Number**. It must have 10 numbers and no spaces, e.g. 0417460421

10. Type the contact's **Fax Number**. It must have 10 numbers and no spaces, e.g. 0247832533.

11. In the **Contact Type** list, select **Alternate**, **Primary** or **FScontact**.

   The **Alternate** and **Primary** contacts are for your service provider organisation. **FScontact** contacts are for associated funding specifications.

   If you select **Primary** and the service provider already has a Primary contact, that Primary contact will automatically change to an **Alternate** contact.

   A service provider may only have one Primary contact but can have numerous Alternate contacts.

12. When adding a new contact, the **Start Date** defaults to today's date.

   If you want to change this date, after saving the new contact, click on the contact row and then select another date. For more information, see [Edit a contact](#).

13. For **Status**, accept the default of **Active**.

14. Click **Save**.

15. To attach an **FScontact** contact to a funding specification, access that funding specification, click the **Contact** tab and then select the contact. For more information, see [Select a funding specification’s contact](#).
Edit a contact

For: SP Admin and SP User

1. On the ECCMS menu, click Service Provider.

2. Click the Contacts tab.

3. Locate and click the contact that you want to edit.
   The Edit Contact dialog box displays.

4. Make any necessary changes, while noting the following:
   - The Phone Number, Mobile Number and Fax number must each have 10 numbers and no spaces.
   - If you change a Contact Type to Primary and the service provider already has a Primary contact, that Primary contact will automatically change to an Alternate contact.
   - To change the Start Date (which defaults to today’s date when adding a new contact), select a date in the calendar.

   For more information about contact details, see Add a new contact.

5. Click Save.
About making a contact inactive

To make either a service provider’s or a funding specification’s Primary contact inactive, you must:

1. Select another contact as the Primary contact.
2. Make the old Primary contact inactive.

When you select another contact as the Primary contact of your service provider organisation, this automatically makes the old Primary contact an Alternate contact.

To make a funding specification’s RCTI contact inactive, you must:

1. Select another contact as the RCTI contact.
2. Make the old RCTI contact inactive.

When you select another contact as a funding specification’s Primary or RCTI contact, they remain in the service provider list as an FScontact.

Only a funding specification’s Alternate contact can directly be made inactive.

Make a contact inactive

For: SP Admin and SP User

1. On the ECCMS menu, click Service Provider.
2. Click the Contacts tab.
3. Locate and click the contact that you want to make inactive.
   The Edit Contact dialog box displays.
4. In the **End Date** calendar, select today's date or the date on which the contact became inactive.

5. In the **Status** list, select **Inactive**.

6. Click **Save**.

---

### Add a new address

ECCMS enables you to add a **Primary** and a **Postal** address for your service provider organisation and to add **Other** addresses for associated funding specifications. An **Other** address can be a funding specification's Street Address or Postal Address.

**For: SP Admin and SP User**

1. On the ECCMS menu, click **Service Provider**.

2. Click the **Addresses** tab.

3. Click **Add New Address**.

The **Add New Address** dialog box displays.

4. In **Address/Building Name**, type the building or address name, e.g. Kindy House.

5. In **Address Line 1**, type the street number and name.

   Or if the address contains additional information, e.g. suite and/or floor number, type that information in **Address Line 1** and the street number and name in **Address Line 2**.

6. In the **Suburb** list, type the first letter (e.g. **k** for Katoomba), and then click the suburb.

   Otherwise, type the first part of the name in the search box that displays at the top of the list.
7. Type the **Post Code**.

8. For **State**, accept the default of **NSW**.

9. In the **Address Type** list, select **Other, Primary or Postal**.

   The **Primary** and **Postal** addresses are for your service provider organisation. **Other** addresses are for associated funding specifications.

   There may be numerous addresses with the types of **Other** and **Postal**.

   To change a service provider’s **Primary** address, you must add a new Primary address. This will automatically change the old Primary address to an **Other** address.

10. For **Status**, accept the default of **Active**.

11. Click **Validate**.

   ECCMS checks the validity of the address and displays any matching addresses in the **Address Search Results** dialog box.

12. Select the matching address and then click **Select**.

   ECCMS automatically adds the correct **LGA** and **Electorate**, which will then display on the Service Provider Main details screen and in the **Edit Address** dialog box.

   If no matching addresses are found, click **Cancel** and proceed to the next step to save the new address. The **LGA** and **Electorate** will not be updated, but this information is not critical as it is mainly required for reporting.

13. Click **Save**.

14. To attach an **Other** address as a funding specification’s postal address, access that funding specification, click the **Addresses** tab and then select the address. For more information, see **Select a funding specification’s postal address**.

   Only DoE can attach an **Other** address as a funding specification’s street address.
Edit an address

It is possible to edit a service provider’s **Primary** address and any **Postal** address. You can also edit a funding specification’s street address (i.e. **Other**) as long as DoE has not yet attached the address to the relevant funding specification.

Only DoE can make changes to a street address when it is attached to a funding specification.

**For: SP Admin and SP User**

1. On the ECCMS menu, click **Service Provider**.
2. Click the **Addresses** tab.
3. Locate and click the address that you want to edit.
   
   The **Edit Address** dialog box displays.

![Edit Address Dialog Box](image)

4. Make any necessary changes.
   
   For more information about address details, see **Add a new address**.

5. Click **Validate**.
   
   ECCMS checks the validity of the updated address and displays any matching addresses in the **Address Search Results** dialog box.

![Address Search Results](image)
6. Select the matching address and then click **Select**. ECCMS automatically adds the correct **LGA** and **Electorate**.

If no matching addresses are found, click **Cancel** and proceed to the next step to save the new address. The **LGA** and **Electorate** will not be updated, but this information is not critical as it is mainly required for reporting.

7. Click **Save**.
About making an address inactive

It is possible to make a service provider’s Primary address and any Postal address Inactive. You can also make a funding specification’s old street address (i.e. Other) inactive if it is no longer attached to the funding specification.

Make a Primary address inactive

For: SP Admin and SP User

1. Add a new Primary address which will then automatically change the old Primary address to an Address Type of Other.
2. Make the old Primary address Inactive.

Make a Postal or Other address inactive

It is possible to make a Postal address Inactive. You can also make a funding specification’s old street address (i.e. Other) inactive as long as it is no longer attached to the funding specification.

Only DoE can make changes to a street address when it is attached to a funding specification.

For: SP Admin and SP User

1. On the ECCMS menu, click Service Provider.
2. Click the Addresses tab.
3. Locate and click the address that you want to make inactive.
   The Edit Address dialog box displays.

4. In the Status list, select Inactive.
5. Click Save.
Add a new bank account

To add a new bank account requires a few steps. When a service provider (or DoE) adds a new bank account, the Status defaults to Draft and an Application for Direct Electronic Funds Transfer form is automatically sent to the service provider. After processing the completed form, DoE changes the bank account’s Status to Active. For information on editing a bank account, see Edit a bank account.

Allow at least two weeks for DoE to process the activation of a new bank account.

Each service provider must have only one nominated and approved bank account.

For: SP Admin and SP User

1. On the ECCMS menu, click Service Provider.
2. Click the Bank Accounts tab.
3. Click Add New Bank Account.
   The Add New Bank Account dialog box displays.

4. In Account Name, type the name of the account e.g. Kindy House.
5. Type the bank’s BSB Number. It must have 6 numbers and no spaces, e.g. 636382.
6. Type the Account Number, e.g. 9484727.
7. Type the Bank Name, e.g. Westpac.
8. In Suburb, type the suburb where the bank is located, e.g. Leura.
9. When adding a new bank account, the Active Date defaults to today's date.
10. When adding a new bank account, Status defaults to Draft.

While the Status is Draft, an SP Admin and SP User can edit all of the details entered in this procedure. However, after the Status is changed to Active, an SP Admin and SP User can only edit the Account Name.
11. **Click Save.**

When a new bank account is created in ECCMS, an email is automatically sent to advise the service provider’s Primary contact as well as DoE.

The Primary contact will also receive (as an email attachment) an *Application for Direct Electronic Funds Transfer* form. This form must be completed for the new bank account and then returned to DoE as soon as possible. When DoE processes the form and sets up the new bank account in the SAP payment system, they will change the bank account’s **Status** to **Active** and advise you via email.

It may take DoE up to two weeks to process a completed form and make a new bank account active.

12. **To attach a bank account to a funding specification,** access that funding specification, **click** the **Bank Account** tab and then select the bank account. For more information, see [Select a funding specification’s bank account](#).

   It is the service provider’s responsibility to attach a new bank account to each of their funding specifications.

13. **If the new bank account is to replace an old account,** after attaching the new bank account to all of your funding specifications, advise DoE so they can make the old bank account inactive.
Edit a bank account

When a bank account in ECCMS has a Draft Status, it can be updated by an SP Admin or SP User.

If you update a bank account's details, you will be required to submit a revised Application for Direct Electronic Funds Transfer form to DoE.

After DoE gives a bank account an Active Status, the only change that an SP Admin or SP User can make is to change the Account Name. If other details need to be changed, you must contact DoE.

For: SP Admin and SP User

1. On the ECCMS menu, click Service Provider.
2. Click the Bank Accounts tab.
3. Locate and click the bank account that you want to edit.
   The Edit Bank Account dialog box displays.

![Edit Bank Account dialog box]

4. Make any necessary changes.
   For more information about bank details, see Add a new bank account.
5. Click Save.
   When a bank account in ECCMS is modified, an email is automatically sent to advise the service provider’s Primary contact and DoE.
Accepting the Terms and Conditions

All service providers are required to agree with the terms and conditions of the Early Childhood Education (ECE) Grants Program and with the guidelines for the relevant grants program(s) to be considered for funding under the program. The terms and conditions include, but are not limited to:

- acceptance of relevant program guidelines
- financial and outcomes reporting
- data collection requirements
- government access requirements
- general audit requirements
- random departmental audits
- conditions of funding withdrawal.

A service provider has to accept the Terms and Conditions, each year in ECCMS.

Variation to Terms and Conditions

If there are changes to the ECE Grants Program during the year, or if a six month extension is awarded, a Variation to Funding Agreement or Variation To Terms and Conditions document may be released for service providers to accept. The duration of a six month extension has the format of year-H, for example, 2017-H.
Save or print the draft Terms and Conditions

ECCMS enables service providers to print and/or save the draft Terms and Conditions agreement so that other staff members in their organisation may review it.

For information on how to save or print an accepted agreement, see Save or print the accepted Terms and Conditions.

For: SP Admin and SP User

1. On the ECCMS menu, click Service Provider.
2. Click the Terms and Conditions tab.

3. Click the Terms and Conditions hyperlink.
   The Terms and Conditions agreement opens in another window in your browser.

4. At the bottom of the agreement, click Print Preview.
   The ‘open or save’ message displays.

5. Click Open.
   The Terms and Conditions agreement displays as a PDF file in a new browser window.

6. To save the agreement so you can view it without being logged into ECCMS:
   - On the File menu, click Save As.
   - Browse to the location where you want to save the file.
   - Click Save.

7. To print the agreement:
   - On the File menu, click Print.
   - Make any necessary selections in the Print dialog box.
   - Click Print.
   (To close the Terms and Conditions windows, click the close button on the top right corner of each window.)
Accept the Terms and Conditions

When required by DoE, service providers must accept the Terms and Conditions.

The online accepted Terms and Conditions document replaces the paper document used in previous years. It becomes part of the contractual record for funding and can be accessed in the future.

For: SP Admin

1. On the ECCMS menu, click Service Provider.
2. Click the Terms and Conditions tab.
3. Click the Terms and conditions hyperlink. The Terms and Conditions agreement opens in another window in your browser.
4. Click the DoE ECE Grants Program Overview hyperlink and read the overview.
5. Under Program Guidelines, click the DoE ECE Grants Program Guidelines hyperlink and read the guidelines.
6. When you are certain that you have read and understood all the terms and conditions and associated guidelines, click Accept.
The Terms and Conditions document will now have a Status of **Accept**, the Accepted Date is set to today’s date, and the name of the person who accepted displays under Accepted By.

The acceptance of the Terms and Conditions is final and cannot be changed.

**Save or print the accepted Terms and Conditions**

After a Terms and Conditions agreement has been accepted, ECCMS converts it to a PDF file which can be retrieved at any time so that you can view, save or print it.

For information on how to save or print a draft agreement, see [Save or print the draft Terms and Conditions](#).

**For: SP Admin and SP User**

1. On the ECCMS menu, click **Service Provider**.
2. Click the **Terms and Conditions** tab.
3. Click the **Terms and Conditions Accepted** hyperlink.
   
   The Terms and Conditions agreement displays as a PDF file in a new browser window or tab.
4. To save the agreement so you can view it without being logged into ECCMS:
   - On the **File** menu, click **Save As**.
   - Browse to the location where you want to save the file.
   - Click **Save**.
5. To print the agreement:
   - On the **File** menu, click **Print**.
   - Make any necessary selections in the **Print** dialog box.
   - Click **Print**.

   You can also print or save the agreement by moving your mouse on it so the navigation pane buttons display. Then click the **Save a copy** button to save the PDF file to your computer, or click the **Print file** button to print a copy.

   If the navigation pane does not display, right-click on the agreement and then on the menu, click **Show Navigation Pane Buttons**.
Managing funding specifications

Only DoE is able to add a new funding specification in ECCMS. After verifying details provided by a service provider, DoE may add a new funding specification (with a Draft Status) at any time during the year. Then after completing final eligibility checks, DoE will approve the funding specification and change the Status to Active.

During the creation of the new funding specification, based on its street address, ECCMS will automatically assign the correct Hub and a SEIFA Band, both of which are used for statistical reporting and internal processing.

Regions in ECCMS have been reorganised into hubs to improve internal processing. To view a map of the hubs, see Appendix A: Early Childhood Education hubs.

A SEIFA (Socio-Economic Index for Areas) Band is based on the Australian Bureau of Statistics index which ranks areas according to relative socio-economic advantage and disadvantage.

Add details for a new funding specification

After a new funding specification is added, a service provider is responsible for ensuring all the following details for the new funding specification are complete and accurate.

Add and select contacts

1. If they are not already recorded in ECCMS, add the funding specification’s Primary Contact and RTCI Contact (and if applicable, the Alternate Contact). For more information, see Add a new contact.
2. Select the funding specification’s Primary Contact and RTCI Contact. If applicable, also select an Alternate Contact. For more information, see Select a funding specification’s contacts.

Add and select a bank account

3. If it is not already recorded in ECCMS, add the funding specification’s bank account. For more information, see Add a new bank account.
4. After receiving the Application for Direct Electronic Funds Transfer form, complete it and return it to DoE.
5. After DoE makes the bank account Active, attach it to funding specification(s). For more information, see Select a funding specification’s bank account.

An SP Admin and an SP User are able to update details for all funding specifications that their service provider organisation operates. However, FS users can only view and make limited updates to the one funding specification they are associated with.
Add and select addresses

6. If they are not already recorded in ECCMS, add the funding specification’s street address (and if applicable, postal address). For more information, see Add a new address.

7. If applicable, select the funding specification’s postal address. For more information, see Select a funding specification’s postal address.

During the creation of a new funding specification, DoE will select the funding specification’s street address.

Add the service details

8. Add the service information, the number and demographic characteristics of the children enrolled, and staffing information for the program that the funding specification operates. For more information, see Adding a funding specification’s service details.
Update funding specification details

An SP Admin and SP User are able to view and update all the funding specifications for their service provider, whereas an FS User only has access to one funding specification. For more information, see Types of users.

Although the following instructions about updating funding specifications are written specifically for an SP Admin and an SP User, the same principles will apply for an FS User.

Locate and view a funding specification

For: SP Admin and SP User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that you want to view.

You can also locate the list of funding specifications by clicking the Service Provider menu option and then clicking the Funding Specifications tab.

The Funding Spec tab is no longer used in ECCMS but is retained for historical records. Service providers who accepted the previously required Funding Spec documents are able to view them here.
Update a funding specification’s main details

For: SP Admin and SP User

1. On the ECCMS menu, click Funding Specification.

2. Locate and click the funding specification that you want to modify.

3. Make any necessary changes.

   An SP Admin can change the Delivery Setting, Phone number and Email on the Main tab. An SP User can change only the Phone number and Email.

   The Phone number must have 10 numbers and no spaces.

4. Click Save.
Add and select contacts, addresses and bank accounts

In ECCMS adding a contact or address to a funding specification consists of two steps – an add step and a select step.

1. **Add the contact or address** via the appropriate tab on the Service Provider Main Details screen.
   
   Only SP Admin, SP User and DoE users can complete this step. FS Users cannot add a contact, address and/or bank account.

2. **Select the contact or postal address** via the appropriate tab on the Funding Specification List screen.
   
   SP Admin, SP User, FS User and DoE users can complete this step.
   
   Only DoE can select a street address.
   
   The steps for adding a bank account in ECCMS are similar. However, after a bank account is added in ECCMS, an Application for Direct Electronic Funds Transfer form is sent to the service provider for completion. DoE then processes the form and makes the bank account active. See [Add a new bank account](#).
Select a funding specification’s contacts

Contacts are selected from the list that has previously been added on the Contacts tab of the Service Provider screen. For more information, see Add a new contact.

A contact can only be made Inactive on the Contacts tab of the service provider screen. For more information, see About making a contact inactive.

**For:** SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that you want to modify.
3. Click the Contacts tab.

All funding specifications must have a Primary Contact and a RCTI Contact (the person to whom the RCTI is sent).

4. To change or add a contact, click the appropriate button, e.g. Select Primary Contact, Select Alternate Contact or Select RCTI Contact.

5. In the selection list, click the circle next to the contact you want to select, and then click Select.
   
   The selection list closes and the selected contact now displays on the Contact tab.

6. Click Save.
Remove a funding specification’s alternate contact

Complete these steps if you want to remove an Alternate Contact and do not want to select a replacement contact.

It is not possible to remove the Primary Contact and RCTI Contact. These contacts can only be changed.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click **Funding Specification**.
2. Locate and click the funding specification that you want to remove the Alternate Contact from.
3. Click the **Contacts** tab.

4. Click **Remove Alternate Contact**.
5. Click **Save**.
Select a funding specification’s bank account

Bank accounts are selected from the list of Active bank accounts that have previously been added on the Bank Accounts tab of the Service Provider screen. For more information, see Add a new bank account.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that you want to modify.
3. Click the Bank Account tab.

4. To add or change the bank account, click Select Bank Account.
5. The Select Bank Account For Funding Specification window displays and lists the service provider’s bank accounts that have an Active Status. In the selection list, click the blue circle next to the bank account that you want to add, and then click Select.

   The selection list closes and the selected bank account now displays on the Bank Account tab.
6. Click Save.
Select a funding specification’s postal address

A postal address is selected from the list that has previously been added on the Addresses tab of the Service Provider screen. A postal address is optional. For more information, see Add a new address.

It is not possible for a service provider to select or change a funding specification’s street address. Only DoE can do this as the street address determines a funding specification’s SIEFA Band.

An address can only be made Inactive on the Addresses tab of the service provider screen. For more information, see About making an address inactive.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that you want to modify.
3. Click the Addresses tab.
4. To add or change the postal address, click Select Postal Address.
5. In the selection list, click the blue circle next to the address that you want to add, and then click Select.
   The selection list closes and the selected address now displays on the Addresses tab.
6. Click Save.
Remove a funding specification’s postal address

Complete these steps if you want to remove a postal address and do not want to select a replacement.

Only DoE can remove or change a street address.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that you want to remove the postal address from.
3. Click the Addresses tab.
4. Click Remove Postal Address.
5. Click Save.
Attach a document to a funding specification

It is possible to attach documents, such as letters and other communications to a funding specification in ECCMS. To fulfil the requirements of the *State Records Act 2000*, all documents uploaded to ECCMS are stored in TRIM which is DoE’s electronic document management system.

ECCMS requires all uploaded documents to be in PDF format. PDF documents should be no more than 10 MB in size.

PDF documents can be created by using the ‘Save As’ function in Microsoft Word or by scanning a document and choosing PDF as the output.

**For: SP Admin and SP User**

1. On the ECCMS menu, click **Funding Specification**.
2. Locate and click the funding specification that you want to add a document to.

3. On the **Main** tab, under **Attach Documents**, click **Choose**.
   
   The **Choose File to Upload** dialog box displays.
4. Browse to and select the PDF document that you want to attach, and then click **Open**. The name of the document displays on the screen.

5. Click **Upload**. ECCMS uploads the document. The document name, your name (i.e. the person who uploaded the document) and the date displays on the screen.
View an attached document

For: SP Admin and SP User

1. On the ECCMS menu, click **Funding Specification**.
2. Locate and click the funding specification that has the attached document.
3. On the **Main** tab, under **Attach Documents**, click the document that you want to view.
   The PDF document opens in a new window.

Cancel a funding specification

If a service provider finds it is necessary to close a funding specification before the end of the year, they should immediately advise DoE of the situation so the funding specification can be cancelled in ECCMS.

When the cancellation is recorded in ECCMS, the payment allocation and all scheduled payments are automatically cancelled from the funding specification. If a recovery of payment is required, this will be done outside the system.
Viewing approvals

An approval is given to a service provider as an authorised provider to run a childcare service. Each approval is uploaded from the National Quality Agenda IT System (NQA ITS) into ECCMS and then checked and approved by DoE.

It is DoE’s role to attach the correct approval to each funding specification.

View a funding specification’s approval

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that you want to view.
3. Click the Approval tab.

4. View the details:
   - Approval ID – from the NQA ITS system.
   - Service Name – usually the name of the funding specification.
   - Provider Name – the service provider name.
   - Maximum Capacity – maximum number of children the service is licensed to have. This will be blank if approval is for service provider.
   - Approval Status – a status uploaded from NQA ITS.
   - Approval Date – when approval was given in NQA ITS.

If a funding specification is a mobile preschool, each of its mobile locations will also have an approval which will display underneath the funding specification’s approval as shown below.
View all service provider approvals

Approvals for funding specifications are uploaded into ECCMS from the NQA ITS system.

For: SP Admin and SP User

1. On the ECCMS menu, click Service Provider.
2. Click the Approvals tab.

All the approvals for your service provider organisation display.

3. View the details:
   - **Service Name** – usually the name of the associated funding specification.
   - **Approval ID** – from the NQA ITS system.
   - **Maximum Capacity** – maximum number of children the outlet is licensed to have.
   - **Status** – a status uploaded from NQA ITS.
   - **Approval Date** – when approval was given in NQA ITS.
Adding a funding specification’s service details

The amount of funding that a service provider receives for a funding specification is calculated on the basis of the program and services they offer. The service details for a funding specification may change from year to year, but generally includes a standard set of service delivery indicators such as service information, the number and demographic characteristics of children enrolled at the service and staffing information.

Service providers must add service details to a new funding specification, which has been added in ECCMS by DoE, and update service details each year after funding specifications are renewed for the new year. The service details are for a reporting period in the year that is nominated by DoE.

The service details determine a funding specification’s allocation for the new year. For more information, see Annual renewal of funding specifications.

Service details entered by service providers are also used as a base against which performance accountability is assessed during the year. For more information, see Managing accountability requirements.

After a DoE approves a funding specification’s allocation, it is not possible to change the service details.

Add or update service details

Until DoE approves a funding specification’s allocation, it is possible to change the service details.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that you want to modify.
3. Click the Service Details tab.

If the funding specification has been rolled over for the next year, the values from the previous year will display in the Client Groups and Service Capacities. If the funding specification is new, all values will be 0.
The groups and capacities that display are different for every program. The example in this topic is for the Long Day Care program.

4. Ensure the correct year displays in the Financial Year list.

5. In the Client Groups and the Service Capacities sections, if the rolled over values are different from the actual values, type over them with the correct values. Otherwise, if the values are the same, leave them as they are.

   If the funding specification is new and the values are all 0, type the correct values.

   Numbers, including dollars, must not contain a decimal point.

6. Click Save.
Tracking allocations and payments

The annual payment allocation for a funding specification is calculated when a funding specification is renewed for the next year or when a new funding specification is created (which can occur any time during the year). Payment allocations are calculated according to service activities, client groups and the number of children included.

Service providers can track DoE’s approval processes for both allocations and payments in ECCMS.

Annual renewal of funding specifications

The process of renewing funding specifications occurs every year and must be completed by the time specified by DoE in time for the first quarterly payment of the new year.

A funding specification’s annual allocation amount as well as the Terms and Conditions and service details for the current year are rolled over in ECCMS before the start of the next year. After the rollover, the Status of the service details for the new year and the allocation Status are both set to Draft.
About indexation, variations and RCTI

Indexation
Payments to a funding specification are subject to adjustment based on the consumer price index (CPI). Generally this happens once a year.

Indexation is applied to a funding specification’s annual allocation at a program level and new amounts are calculated for remaining payments for the year. Indexation details are entered in ECCMS by DoE.

Variations
During a year, changes to a funding specification’s service details as result of data collection, accountability reporting or a change in a program’s funding model may necessitate a variation of the approved allocations. A variation may result in either an increase or reduction of the annual allocation and future payments. For more information, see Track a variation.

RCTI
ECCMS, combined with other DoE systems, automatically generates a Recipient Created Tax Invoice (RCTI) against each payment made to a service provider for a funding specification.

An RCTI will have itemised information about payments made and is for the service provider’s own tax records.
View a funding specification’s allocation

All funding specifications receive **annual** allocations which are listed on the **Allocations** tab. However, if there is an approved requirement for additional funding, a **one off** allocation may be made.

**For:** SP Admin, SP User and FS User

1. On the ECCMS menu, click **Funding Specification**.
2. Locate and click the funding specification that you want to view.
3. Click the **Allocations** tab.

<table>
<thead>
<tr>
<th>Financial Year</th>
<th>Allocation Name</th>
<th>Allocation Amount</th>
<th>Next Year Base Amount</th>
<th>Allocation Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017-F</td>
<td>Annual 2017-F</td>
<td>$240,000.00</td>
<td>$240,000.00</td>
<td>Annual</td>
<td>Draft</td>
</tr>
</tbody>
</table>

If an allocation’s **Status** is:

- **Draft**, DoE has entered the allocated amount, which is waiting to be certified by a DoE manager.
- **Certify**, a DoE manager has certified the amount which must now be approved by another DoE manager.
- **Approved**, a DoE manager has approved the allocated amount, and quarterly draft payments have been scheduled in the system. The quarterly payments will now be listed on the **Payments** tab with a **Status of Draft** (or **Certified** if DoE has certified them).

**Allocation Types** may be **Annual** or **One Off**. One off allocations are made for adhoc payments and/or variations.

The **Allocation Amount** is the amount allocated for the current year. The **Next Year Base Amount** is the amount that will be rolled over for the next year and then adjusted.

4. Click the allocation row to view further details, e.g. the reason for a one off payment.
View a funding specification’s payments

After DoE certifies and approves a funding specification’s allocation, quarterly payments for the year are automatically scheduled in ECCMS. On the scheduled dates, electronic payments are made to service provider bank accounts via DoE’s SAP system.

Service provider users are able to view payments (historical and future) for their own funding specifications.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that you want to view.
3. Click the Payments tab.
4. To view the payment details for a particular year, type that year (in part or full) in the Financial Year search box.
5. View the payment details:
   - The type of allocation displays under Allocation Type. The most common type of allocation is an Annual allocation. However, some service providers may qualify for a One Off payment. For more information, see Track a one off allocation.
   - The annual allocation for each program is broken up into quarterly payments which display in the Amount column.
   - The date on which a payment is intended to be paid is the Payment Date.
   - The date on which a payment is actually processed is the Process Date.
   - If a payment has a:
     - Draft Status, the allocation has been approved, but the payment is not yet certified by DoE.
     - Certified Status, the payment has been certified and will be paid at the scheduled date.
     - Sent to SAP Status, the details of the payment have been sent to SAP which is DoE’s financial payments system.
     - SAP Paid Status, the payment has been made to the funding specification’s nominated bank account.
   - The Invoice No is the number generated by SAP when a payment is made.
Track a one off allocation

If annual payments have already been scheduled for a funding specification and there is an approved requirement for additional funding, a one off allocation may be made.

A one off allocation will originally display on the Allocations tab of the Funding Specification screen with a Status of Draft. It must then go through the same approval and certification process as an annual allocation.

One off allocations are not rolled over to the next year when the funding specification is renewed.

Track a variation

During the year, changes to a funding specification’s service details as a result of data collection or a change in a program’s funding model may necessitate a variation of the approved allocation. Each payment variation is applied to the annual funding allocation and future payments are adjusted.

When DoE records a variation in ECCMS the allocation amount is updated so that it either reduces or increases future payments. If an increase is determined, future payments may be increased and/or an adhoc payment may be made as an adjustment.

The following example takes you through a positive variation of $3,000 that is applied to the remaining payments for a year.

**Allocations and payments before a variation**

The below screenshot shows the Variations tab of a new funding specification (created half way through the year) that has a base annual allocation of $120,000 and an Allocation Amount of $60,000 for the remainder of the year.

No variations have been applied to the funding specification’s annual allocation.
The next screenshot shows the Payments tab for the same funding specification which shows the two remaining quarterly amounts of $30,000 (making a total of $60,000) to be paid for the remainder of the year.

### Allocations and payments after a variation

The below screenshot shows the Variations tab of the funding specification which has now been granted a positive variation of $3,000. As a result, the base annual allocation of $120,000 has increased to $123,000.

The next screenshot shows the funding specification’s Payments tab which shows the two remaining amounts of $30,000 to be paid for the year, have been increased by the variation of $3,000 divided by the number of remaining payments.
Managing accountability requirements

DoE must have appropriate documentary evidence regarding the use of public funding so the Department can meet its financial accountability obligations to demonstrate and justify the use of public resources to government, the Parliament and the community. Service providers must therefore meet financial and performance accountability requirements to ensure funded programs achieve government policy objectives and are consistent with eligibility rules. To fulfil these requirements, service providers must submit the following statements in ECCMS for each funding specification:

- **Statement of Expenditure** due at the end of April or October each year depending on whether the service provider’s reporting period is January to December, or July to June.
- **Performance Accountability Statement** due at the end of September each year.

Both statements may be completed by SP Admin, SP User and FS Users, however, only an SP Admin has the authority to submit a statement on behalf of a service provider and legally bind it. After a Statement of Expenditure or Performance Accountability Statement has been submitted, a copy that contains all the information submitted, can be viewed, saved and printed by all users.

After the statements are submitted, DoE will assess them to check whether service providers have complied with their contractual obligations, and to ensure funds have been used as intended and can be accounted for. If there is a problem with a statement, a DoE staff member will phone the service provider’s primary contact and request that the statement be resubmitted with the required information.

Reminders

If a funding specification’s Statement of Expenditure or Performance Accountability Statement is due for submission, SP Admin users will receive a reminder message (see View and manage the Reminder) as well as a ‘Financial Accountability’ or a ‘Performance Accountability’ message when they access the funding specification via the To-do List (see Understand the To-Do List). To clear an ‘accountability’ message, click OK.

Financial accountability message

Performance accountability message
Financial accountability

In accordance with the Terms and Conditions agreement with DoE, each year service providers must submit a Statement of Expenditure for each funding specification. The Statement of Expenditure is used by DoE to provide a measure of assurance and evidence that public funds have been spent for their intended purpose.

In 2014, a questionnaire was sent to all service providers to determine which month they acquit their organisation’s accounts. Depending on the answer to this questionnaire, each service provider’s reporting month was updated in ECCMS.

Depending on the service provider’s reporting period, in January or July, an email notification will be sent to the primary contact of each funding specification to advise them that the year’s Statement of Expenditure is ready for completion and has been added to the Accountability tab in ECCMS. Service providers who have June as their reporting month must submit their Statement of Expenditure by October in that year. Service providers who have December as their reporting month must submit their statement by April the following year.

Performance accountability

Each year, service providers must submit, for each of their funding specifications, a Performance Accountability Statement that covers a two week period of operation. This statement is used by DoE to monitor actual performance against the estimates for service types, client groups and service capacities as recorded on each funding specification’s Service Details tab.

At least six weeks before a Performance Accountability Statement is due, an email notification will be sent to the primary contact of each funding specification to advise them that the statement has been added to the Accountability tab in ECCMS and is ready for completion.

Accountability flag

When a new service provider is added in ECCMS, DoE enters all the relevant details, and then assigns an Accountability Flag. The purpose of the flag is to categorise the service provider and associated funding specifications as either a Tier-1 or a Tier-2 organisation for DoE’s financial accountability reporting.

**Tier-1 service providers**

Tier-1 Service providers may be one or more of the following:

- Organisations with a total income greater than $250,000 (including Shire or Municipal Councils, Local Health Districts, Universities and TAFEs)
- A public company limited by guarantee
- Any service provider that is not a Tier-2 service provider.

**Tier-2 service providers**

Tier-2 service providers may be one or more of the following:

- Organisations with a total income of less than or equal to $250,000
- Shire or Municipal Councils, Local Health Districts, Universities and TAFEs.
Financial accountability questionnaire

Once every year the Financial Accountability Questionnaire displays when a service provider clicks the Financial link to complete the Statement of Expenditure. If a service provider's income or commercial arrangements have changed, this provides an opportunity to decide which tier their organisation now belongs to for reporting purposes.

![Financial Accountability Questionnaire](image)

Financial documents for Tier-1 and Tier-2 service providers

Before completing the Statement of Expenditure, you must have the following financial documents ready – depending on whether your organisation is a Tier-1 or Tier-2 service provider.

<table>
<thead>
<tr>
<th>Tier-1</th>
<th>Tier-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audited Financial Statements (including audit certificate)</td>
<td>Statement of Income</td>
</tr>
<tr>
<td>Profit and Loss Statement</td>
<td>Profit and Loss Statement</td>
</tr>
<tr>
<td>Standard Chart of Accounts (if available)</td>
<td>Balance Sheet and Statement of Equity</td>
</tr>
<tr>
<td>Any other supporting document</td>
<td>Any other supporting document</td>
</tr>
</tbody>
</table>

ECCMS requires all uploaded documents to be in PDF format. PDF documents should be no more than 10 MB in size.
Complete the Statement of Expenditure

When a Statement of Expenditure is added to a funding specification’s Accessibility tab in ECCMS, it has a Status of Draft. After the statement is submitted, its Status changes to Submitted.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification with the Statement of Expenditure that you want to complete.
3. Click the Accountability tab.

4. Locate the correct Financial Year, and then under Accountability Statement, click the Financial hyperlink.
5. If the Financial Accountability Questionnaire displays, select whether your organisation is Tier-1 or Tier-2 and then click Submit. See Financial accountability questionnaire.

The Statement of Expenditure opens in a new window and displays the annual funding amount in Total Funding to Acquit (as per funding specification). If one-off funding was also granted, this displays in One-off Funding to Acquit.
Income

When entering amounts, you can enter the amount with or without a comma as ECCMS will accept both formats. For example, you can type 25,000 or 25000. ECCMS will add the comma (if it is missing) and also add ‘00’ for the cents – for example, $25,000.00.

6. In **Service User Fees**, type the total amount of fees that the funding specification received during the year.

The total amount of fees must not include Child Care Benefit (CCB) payments.

7. In **Sale of Assets**, type the total amount received during the year for the sale of any of the funding specification's assets that were purchased with ECE funding. If no assets were sold, type 0.

It is only possible to save or submit the Statement of Expenditure when all fields have a number. If a field is not applicable for the funding specification, type 0. When you type 0 in ECCMS, it automatically changes to $0.00.

8. In **Grant funding from other sources**, type the total amount of funding the funding specification received during the year from any sources other than DoE. If no funding was received from other sources, type 0.

Expenditure

9. In **Salaries and Wages: service delivery staff**, type the total amount spent during the year on salaries and wages for staff who directly delivered the funding specification’s services.

10. In **Salaries and Wages: administration and management staff**, type the total amount spent during the year on salaries and wages for staff who performed the funding specification’s administration, accounting and management duties.

11. In **Depreciation**, type the amount that the funding specification’s assets depreciated during the year.

12. In **Operating Costs**, type the total amount spent during the year on the funding specification’s operating costs such as cleaning, property maintenance, equipment repair and catering.

13. In **Administration Costs**, type the total amount spent during the year on the funding specification’s administration costs such as audit and accountancy fees, professional fees, printing, stationary and postage.

14. In **Asset / Capital Acquisitions (one-off or capital only)**, type the total amount granted from DoE. If no grant was received, type 0.

15. In **Loss on Sale of Assets**, type the total amount of loss incurred during the year for the sale of any assets belonging to the funding specification which were purchased with ECE funding. If no loss was incurred, type 0.

Surplus

16. In **Total Amount**, type the total amount of funding from DoE that the funding specification did not spend during the year. If all funding was spent, type 0.
Upload financial attachments

It is possible to exit the Statement of Expenditure without uploading the financial attachments. If you wish to save now and upload the documents later, click Save.

For Tier-1 organisations, the screen displayed is:

![2016 Financial Attachments for Tier-1 organisations](image1)

For Tier-2 organisations, the screen displayed is:

![2016 Financial Attachments for Tier-2 organisations](image2)

Only a single PDF document can be attached for each document type. This means you may need to combine documents into one PDF file.

17. Under the Financial Attachments section, attach a PDF document to the Statement of Expenditure by clicking the appropriate Attach Document hyperlink. The listed documents will differ according to whether your service provider organisation is a Tier-1 or a Tier-2 organisation.

The Attach Document dialog box displays.
18. Click Choose.
   The Choose File to Upload dialog box displays.

19. Browse to and select the PDF document that you want to attach, and then click Open.
   The name of the document displays on the dialog box.

20. Click Upload.

21. Repeat steps 17 to 20 to upload all the relevant documents.

22. Click Save.

The Statement of Expenditure’s Status remains as Draft.
Remove or replace an attached document

Before a Statement of Expenditure is submitted, it is possible to remove a document and replace it with another document.

ECCMS requires all uploaded documents to be in PDF format. PDF documents should be no more than 10 MB in size.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification with the attached document that you want to remove or replace.
3. Click the Accountability tab.

4. Locate the correct Financial Year, and then under Accountability Statement, click the Financial hyperlink.
   The Statement of Expenditure opens in a new window.
5. Scroll down to the Financial Attachments section.

6. Next to the document that you want to remove, click the Remove Document hyperlink.
Managing accountability requirements

Remove or replace an attached document

The **Confirm Removal of Attachment** message displays.

7. Click **Yes**.

8. To replace the document, click the adjacent **Attach Document** hyperlink.

   The **Attach Document** dialog box displays.

9. Click **Choose**.

   The **Choose File to Upload** dialog box displays.

10. Browse to and select the PDF document that you want to attach, and then click **Open**.

   The name of the document displays on the dialog box.

11. Click **Upload**.

12. Click **Save**.

**Submit the Statement of Expenditure**

13. If you are sure all numbers and uploaded documents are correct, click **Submit**.

   The Statement of Expenditure’s **Status** changes to **Submitted** and an email is sent to DoE who then checks the details and either accepts or rejects your statement.
Submit the Statement of Expenditure

Only the SP Admin is authorised to submit a funding specification’s Statement of Expenditure. After the Statement of Expenditure is submitted, its Status changes from Draft to Submitted.

For: SP Admin

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification that has the Statement of Expenditure that you want to submit.
3. Click the Accountability tab.

4. Locate the correct Financial Year, and then under Accountability Statement, click the Financial hyperlink.
   
   The Statement of Expenditure form opens in a new window.

5. Check that the numbers are correct and make any necessary changes.
6. Check that the correct documents have been attached. To view a document, click the appropriate Download Document hyperlink.

   To replace a document, first click the Remove Document hyperlink and then click the adjacent Attach Document hyperlink. For more information, see Remove or replace an attached document.

Preview, save and print the Statement of Expenditure

7. Scroll down to the bottom of the statement, and then click Preview.
   
   The ‘open or save’ message displays.

8. Click Open.
   
   The Statement of Expenditure displays as a PDF file in a new browser window.

9. To save the Statement of Expenditure so you can view it without being logged into ECCMS:
   - On the File menu, click Save As.
   - Browse to the location where you want to save the file.
   - Click Save.
10. To print the Statement of Expenditure:
   - On the **File** menu, click **Print**.
   - Make any necessary selections in the **Print** dialog box.
   - Click **Print**.

   (To close the statement window, click the close button on the top right corner of each window.)

**Submit the Statement of Expenditure**

![Submit the Statement of Expenditure dialog box](image)

11. If you are sure all numbers and uploaded documents are correct, select the **Accept** check box.

12. Click **Submit**.

   A confirmation and information message displays.

![Confirmation message](image)

13. Click **OK**.

   The Statement of Expenditure’s **Status** changes to **Submitted**. An email is sent to DoE who then checks the details and either accepts or rejects your statement.
View the submitted statement and documents

After the Statement of Expenditure and attached documents are submitted, they are stored in TRIM, DoE’s electronic document management system, from which they can be viewed in ECCMS.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification with the submitted statement and documents that you want to view.
3. Click the Accountability tab.

4. Locate the correct Financial Year, and then under Accountability Statement, click the Financial hyperlink.
   The ‘open or save’ message displays.

5. Click Open.
   In Windows Explorer, ECCMS opens a folder (e.g. FinancialAccountability-2016-Kindy House) that contains PDF files of the Statement of Expenditure and attached documents.
   If your version of Windows does not automatically extract compressed files, instead of a folder, ECCMS will open a zip file. To open the zip file and view the compressed files, you will need to install extraction software such as WinZip on your computer.

6. Save the PDF files to your computer or computer network.

7. To print any of the PDF files:
   - Double-click the file to open it.
   - On the File menu, click Print.
   - Make any necessary selections in the Print dialog box.
   - Click Print.

   (To close a PDF file, click the close button on the top right corner of each window.)
Resubmit a rejected Statement of Expenditure

If there is a problem with your Statement of Expenditure and attached documents, a DoE staff member will phone you and request additional information. They will then reject your Statement of Expenditure in ECCMS so its Status of Submitted reverts to Draft. You must then make the required changes and resubmit the statement.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification with the Statement of Expenditure that you want to resubmit.
3. Click the Accountability tab.

4. Locate the correct Financial Year, and then under Accountability Statement, click the Financial hyperlink.
   The Statement of Expenditure with your previously entered data and attached documents opens in a new window.
5. Make any necessary changes to the data.
6. If applicable, replace an attached document and/or attach a new document. For more information, see Remove or replace an attached document.

Preview, save and print the Statement of Expenditure

7. Scroll down to the bottom of the statement, and then click Preview.
   The ‘open or save’ message displays.

8. Click Open.
   The Statement of Expenditure displays as a PDF file in a new browser window.
9. To save the Statement of Expenditure so you can view it without being logged into ECCMS:
   - On the File menu, click Save As.
   - Browse to the location where you want to save the file.
   - Click Save.
10. To print the Statement of Expenditure:
   ▪ On the File menu, click Print.
   ▪ Make any necessary selections in the Print dialog box.
   ▪ Click Print.

   (To close the Terms and Conditions windows, click the close button on the top right corner of each window.)

Submit the Statement of Expenditure

Please select 'Accept' to acknowledge that you have completed all the accountability requirements as detailed which are by virtue of this Statement to be contractually binding upon your organisation.

Accept

Submitted by: Rolan Sanjoev
Date:

Submit  Save  Preview  Cancel

11. If you are sure all numbers and uploaded documents are correct, select the Accept check box.

12. Click Submit.

   The 'submitted successfully' message displays, the Statement of Expenditure’s Status changes to Submitted, and an email is sent to DoE who then checks the details and either accepts or rejects your statement.
Complete a Performance Accountability Statement

Preschool organisations do not need to complete the Performance Accountability Statement because their service details are uploaded from the Children’s Services Data Collection (CSDC) tool. However, preschools still have to submit the Performance Accountability Statement. For more information, see Submit a Performance Accountability Statement.

Before starting to complete the Performance Accountability Statement, so you can enter the required information, you should gather the funding specification’s client group and service capacity statistics for the required Reporting Period as specified in the email notification that you received from DoE.

When a Performance Accountability Statement is added to a funding specification’s Accessibility tab in ECCMS, it has a Status of Draft. After the Performance Accountability Statement is submitted, its Status changes to Submitted.

For: SP Admin, SP User and FS User

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification with the Performance Accountability Statement that you want to complete.
3. Click the Accountability tab.
4. Locate the correct Financial Year and Reporting Period, and then under Accountability Statement, click the Performance hyperlink.
The Performance Accountability Statement opens in a new window and displays information in the Previously Recorded and Actual Value columns, which you previously entered on the Service Details tab.

5. For each applicable Client Group, type over any out-of-date values in the Actual Value column with the correct values for the reporting period.
   
   Numbers, including dollars, may not contain a decimal point.

6. For each Service Capacity, type over any out-of-date values in the Actual Value column with the correct values for the reporting period.

7. Click Save.
   
   The 'saved successfully' message displays.

The Performance Accountability Statement’s Status remains as Draft.
Submit a Performance Accountability Statement

Only the SP Admin is authorised to submit a funding specification’s Performance Accountability Statement.

After the Performance Accountability Statement is submitted, its **Status** changes from **Draft** to **Submitted**. DoE staff will then review the statement and either approve or reject it. An approved statement has an **Approved Status** and a rejected statement reverts back to a **Draft Status**.

**For: SP Admin**

1. On the ECCMS menu, click **Funding Specification**.
2. Locate and click the funding specification with the Performance Accountability Statement that you want to submit.
3. Click the **Accountability** tab.

4. Locate the correct **Financial Year** and **Reporting Period**, and then under **Accountability Statement**, click the **Performance** hyperlink.

   The **Performance Accountability Statement** opens in a new window.

5. Check that the values in the **Actual Value** column are correct for the **Reporting Period**, and then make any necessary changes.

   Preschool organisations are not able to change the numbers because their service details are uploaded from the Children’s Services Data Collection (CSDC) tool. However, preschools still have to submit the Performance Accountability Statement.

**Preview, save and print the Performance Accountability Statement**

6. Scroll down to the bottom of the statement, and then click **Preview**.

   The ‘open or save’ message displays.

7. Click **Open**.

   The Performance Accountability Statement displays as a PDF file in a new browser window.

8. To save the Performance Accountability Statement so you can view it without being logged into ECCMS:
   - On the **File** menu, click **Save As**.
   - Browse to the location where you want to save the file.
   - Click **Save**.
9. To print the Performance Accountability Statement:
   - On the **File** menu, click **Print**.
   - Make any necessary selections in the **Print** dialog box.
   - Click **Print**.

   (To close the statement window, click the close button on the top right corner of each window.)

**Submit the Performance Accountability Statement**

![Image of the Performance Accountability Statement submission form]

10. If you are sure all numbers are correct, select the **Accept** check box.

11. Click **Submit**.

   The 'submitted successfully' message displays, the Performance Accountability Statement’s **Status** changes to **Submitted**, and an email is sent to DoE who then checks the details and either accepts or rejects your statement.
View a submitted Performance Accountability Statement

After the Performance Accountability Statement is submitted, it is stored in TRIM, DoE’s electronic document management system, from which it can be viewed in ECCMS.

**For: SP Admin, SP User and FS User**

1. On the ECCMS menu, click **Funding Specification**.
2. Locate and click the funding specification with the submitted statement that you want to view.
3. Click the **Accountability** tab.
4. Locate the correct **Financial Year** and **Reporting Period**, and then under **Accountability Statement**, click the **Performance** hyperlink.
   The 'open or save' message displays.
5. Click **Open**.
   The Performance Accountability Statement displays as a PDF file in a new browser window.
6. To save the Performance Accountability Statement so you can view it without being logged into ECCMS:
   - On the **File** menu, click **Save As**.
   - Browse to the location where you want to save the file.
   - Click **Save**.
7. To print the Performance Accountability Statement:
   - On the **File** menu, click **Print**.
   - Make any necessary selections in the **Print** dialog box.
   - Click **Print**.

(To close the statement window, click the close button on the top right corner of each window.)
Resubmit a Performance Accountability Statement

If there is a problem with your Performance Accountability Statement, a DoE staff member will phone you and advise what additional information is required. They will then reset your Performance Accountability Statement in ECCMS so its Status of Submitted reverts to Draft. You must then make the required changes and resubmit the statement.

Preschool organisations will not need to resubmit their Performance Accountability Statement because it is based on approved data from the Children’s Services Data Collection (CSDC) tool.

For: SP Admin

1. On the ECCMS menu, click Funding Specification.
2. Locate and click the funding specification with the Performance Accountability Statement that you want to resubmit.
3. Click the Accountability tab.
4. Locate the correct Financial Year and Reporting Period, and then under Accountability Statement, click the Performance hyperlink.
   
   The Performance Accountability Statement with your previously entered values opens in a new window.
5. Make any necessary changes to the values.

Preview, save and print the Performance Accountability Statement

6. Scroll down to the bottom of the statement, and then click Preview.
   
   The ‘open or save’ message displays.
7. Click Open.
   
   The Performance Accountability Statement displays as a PDF file in a new browser window.
8. To save the Performance Accountability Statement so you can view it without being logged into ECCMS:
   - On the File menu, click **Save As**.
   - Browse to the location where you want to save the file.
   - Click **Save**.

9. To print the Performance Accountability Statement:
   - On the File menu, click **Print**.
   - Make any necessary selections in the **Print** dialog box.
   - Click **Print**.
   (To close the statement window, click the close button on the top right corner of each window.)

**Submit the Performance Accountability Statement**

![Image of the submit form]

10. If you are sure all numbers are correct, select the **Accept** check box.

11. Click **Submit**.
   - The 'submitted successfully' message displays, the Performance Accountability Statement’s **Status** changes to **Submitted**, and an email is sent to DoE who then checks the details and either accepts or rejects your statement.
Managing applications

The Applications function in ECCMS is occasionally used to gather information for specialised grants, for example for rural and remote preschools.

It is only necessary to complete an application, if you are directed to do so by DoE.

For: SP Admin

1. On the ECCMS menu, click Applications.
   Any applications or sub programs that are applicable to your service provider organisation for the current year will display.

2. In the Applications list, under Application Status, click Draft.
3. Complete and submit the application as instructed by DoE.
Managing users

An SP Admin user (i.e. Service Provider Administrator) is able to create ECCMS user accounts for their own staff. An SP Admin user is created by DoE when setting up a new service provider or when advised that an existing SP Admin user is leaving the service provider organisation.

Because an SP Admin user is responsible for the security of their organisation’s banking details, as well as user accounts, they must ensure appropriate control is maintained over this information. For example, an SP Admin should promptly make a user inactive, if that user is no longer employed by their organisation.

For audit purposes, service providers should have only one active SP Admin user.

Before staff can log into their ECCMS user account, they must have an AUSkey installed on their computer. For more information, see Managing AUSkey registrations.

Types of users

Each service provider may have three types of users who have varying levels of access to ECCMS. These users are:

- **SP Admin** – A user with the highest level access within a service provider organisation. As well as updating service provider details, and accepting Terms and Conditions agreements, they can create SP Users and FS Users.
- **SP User** – Users who manage data for all of a service provider’s funding specifications.
- **FS User** – Users who have limited view and update access to one funding specification’s data.

The following table lists the ECCMS tasks and functions that each type of user can perform.

<table>
<thead>
<tr>
<th>ECCMS tasks and functions</th>
<th>SP Admin</th>
<th>SP User</th>
<th>FS User</th>
</tr>
</thead>
<tbody>
<tr>
<td>View/update service provider main details</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td>Add new contacts</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td>Make a contact inactive</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td>Add new addresses</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td>Make an address inactive</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td>Add new bank accounts</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td>Edit draft bank accounts</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td>View list of service provider approvals</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td>View Terms and Conditions</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
</tbody>
</table>
## Types of users

### Managing users

#### ECCMS tasks and functions

<table>
<thead>
<tr>
<th>Task Description</th>
<th>SP Admin</th>
<th>SP User</th>
<th>FS User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept Terms and Conditions</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Update funding specification’s phone number and email address</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Update funding specification’s delivery setting</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Attach and upload documents for a funding specification</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Select a funding specification’s contact, postal address and bank details</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Remove a funding specification’s alternate contact</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Remove a funding specification’s postal address</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View a funding specification’s approval</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Add a funding specification’s service details</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View a funding specification’s allocations</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View a funding specification’s variations</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View a funding specification’s payments</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Complete, save and view financial and performance accountability details</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Submit financial and performance accountability details</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Enter and view application data</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Manage SP Users and FS Users</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Enter and/or view census data</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Submit census data</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>
Add a new user

For: SP Admin

1. Ensure the new user has registered with the Australian Government Authentication Service, downloaded an AUSkey, and installed it on their computer. For more information, see Manage AUSkey registrations.

2. On the ECCMS menu, point to Administration, and then click User Details.

3. Click Add New Service Provider User.

The Create New Service Provider User dialog box displays.

4. Type the contact's First Name and Family Name.

5. In Email, type the user's email address.

6. When adding a new user, Status defaults to Active.

7. In the Roles list, select either
   - **SP-USER** – Updates information regarding your organisation and associated funding specifications.
   - **FS-USER** – Only views information regarding a certain funding specification (selected in step 8).

   Make sure you assign the correct user role as it determines the new user's authorisation level. Service Provider and ABN cannot be changed.

8. If the user is an **FS-User**, in the list, select the appropriate Funding Specification.

9. Click Save.

An email is sent to the new user advising them of their ECCMS registration, unique registration key and login details.
Edit a user

For: SP Admin

1. On the ECCMS menu, point to Administration, and then click User Details.

2. Locate and click the user you want to edit.

   The Edit Service Provider User dialog box displays.

   ![Edit Service Provider User dialog box]

3. Make any necessary changes, while noting the following:
   - **SP-USER** – Updates information regarding your organisation and associated funding specifications.
   - **FS-USER** – Only views information regarding a certain funding specification. If the user is a FS-User, in the list, select the appropriate Funding Specification.

   Make sure you assign the correct user role as it determines the new user’s authorisation level. For more information about user details, see Add a new user.

   Service Provider, ABN, and Registration Key cannot be changed.

4. Click Save.
Make a user inactive

For: SP Admin

1. On the ECCMS menu, point to Administration, and then click User Details.
2. Locate and click the user you want to make inactive.
   The Edit Service Provider User dialog box displays.

3. In the Status list, select Inactive.
4. Click Save.
Appendix A: Early Childhood Education hubs

The following map shows the location of the Early Childhood Education hubs which have been implemented to assist internal management.